GOOGLE SUITE
# Table of Contents

Google Suite .................................................................................................................................................. 3

- How do I link my Google Drive to Canvas? ................................................................................................. 4
- How do I unlink Canvas and Google Drive? ...................................................................................................... 11
- How do I embed or link Google Drive content into a Canvas Rich Content Editor? .......................... 14
- How do I set up a Google Docs Cloud Assignment in Canvas? ...................................................................... 17
- How do I use a Google Doc as a Canvas assignment description/prompt? .............................................23
- How do I submit an assignment from Google Drive in Canvas? .............................................................. 28
- How do I create a copy of a Google Doc to post as a Discussion reply? ...................................................... 34
- How do I embed a Google Form in a Canvas discussion? .......................................................................... 40
- How do I use Google Forms and Sheets to automatically generate custom certificates? .................. 53
- How do I use Google Sheets to update course Assignments and Quizzes in bulk? ............................ 74
- How do I submit a Google Docs Cloud Assignment as a student? .......................................................... 87
- How do I open Microsoft Office Files (Word, Excel, PowerPoint) on my Chromebook? .................. 89
- How do I create a new Microsoft Office File (Word, Excel, PowerPoint) on my Chromebook? ............ 92
- How do I use the Google Calendar? ............................................................................................................... 95
- How do I schedule a Zoom Meeting using Google Calendar? ............................................................... 116
- How do I copy the contents of my U drive to Google Drive? .................................................................... 123
- How do I share contents of my Google Drive with my class (using CRN)? .............................................. 136
Google Suite
How do I link my Google Drive to Canvas?

In this tutorial, you will learn how to link your Google account to your Canvas account. This will allow for direct access to your Google Drive contents within Canvas. Users can then embed or link documents from Google Drive into Canvas Assignments, Discussions, Pages, etc.

Documents which are embedded or linked from your Google Drive are automatically updated in Canvas when you update them in your Drive.

**IMPORTANT MESSAGE:** Before you begin, make sure you are not logged in to Google or your Chrome Browser with a personal account other than your HSU account. This can cause problems with the integration.

If you think you have a personal account linked, or are experiencing difficulties, please follow this guide to unlink a Google account.

The most common error we have with Google Drive and Canvas is students (and faculty) who are logged into Google with their personal credentials and not their school credentials:

- e.g., Alex Smith has a ajs001@humboldt.edu identity, as well as a alexsmith@gmail.com identity. They are logged into Google as alexsmith@gmail.com.

When they try to access something in Google Drive through Canvas, it will most often fail, since items within Google Drive are commonly shared only to those in the domain "@humboldt.edu".

1. **Make sure you are not logged in to Google**

Check whether you're signed into any other Google accounts. To do so, go to google.com and look at the upper right.

If you see this blue **Sign in** button, proceed to Step 2: Make sure you are not logged in to the Chrome Browser.
If you see a circular profile image or your initials:

1. Click the **profile image** or **first initial** to view the accounts that you're currently logged into.
2. Click **Sign out** to sign out of all of your Google accounts.

---

2. **Make sure you are not logged in to the Chrome Browser**

If you are not using Google Chrome, proceed to [Step 3: Open Google Drive in the Course Navigation Menu](#).

If you are using Google Chrome:

1. Click the **three dots** in the upper left corner of the browser window to open the menu.
2. Click **Settings**.
3. In the People area at the top:

   - If you see a **SIGN IN TO CHROME** button, proceed to [Step 3: Open Google Drive in the Course Navigation Menu](#).
   - If you see your Name and a **SIGN OUT** button, click **SIGN OUT**.
Proceed to Step 3

Sign in to get your bookmarks, history, passwords, and other settings on all your devices. You'll also automatically be signed in to your Google services. Learn more

Manage other people

Import bookmarks and settings
3. Open Google Drive in the Course Navigation Menu

To link your Google Drive to your Canvas account, start by selecting Google Drive from any Course Navigation Menu.

4. Authorize your Google Account

If you have no currently linked Google account to your Canvas account, you will see a message prompting you to log in.
Log In

You need to authorize this integration in order to use it.
Please sign in to your Google account and authorize this integration.

At the bottom of this page is an **AUTHORIZE** button to log into your Google Account.

5. Sign into your Google Account

After clicking **AUTHORIZE**, you will either be logged in automatically or you will be prompted to enter your email address.

⚠️ If you are prompted to enter your email address, make sure to use your HSU email.
If prompted, allow instructure.com access to your Google Drive.

6. View your Google Drive

Once your accounts are linked, you should see the contents of your Google Drive.
Again, if you think you have a personal account linked, or are experiencing difficulties, please follow this [guide to unlink a Google account](#).
How do I unlink Canvas and Google Drive?

In this tutorial you will learn how to unlink your Google Account from Canvas by deleting the key from your Canvas Account Settings.

💡 To link a different Google Account to Canvas you may need to sign out of your Google Account first.

⚠️ Unlinking your Google account from the Canvas course will make all embedded material inaccessible via Canvas.

1. Open Accounts Settings

Select **Account** from the Global Navigation Menu, and then select **Settings** from the newly opened menu.
2. Remove the Approved Integrations key

Scroll down on your Accounts page until you reach the Approved Integrations section. Locate the Google Drive LTI IAD-Prod key and then select the trash icon. A pop-up dialog will prompt if you are sure; select OK.
3. Link your HSU Account

You are now ready to authorize your HSU Google account with Canvas. Follow this guide for assistance.
How do I embed or link Google Drive content into a Canvas Rich Content Editor?

In this tutorial you will learn how to embed or link to Google Drive content within the Canvas Rich Content Editor.

If you need help authorizing your Google Account on Canvas, follow this guide.

1. Add a Google Drive Item to the Assignment Description

1. Above the assignment description text area, click on the blue, downward pointing arrow for More External Tools.
2. Select Google Drive.

![Google Drive Selection](image)

2. Find the desired document

Once you select Google Apps from the drop down menu, a dialog window should open displaying the contents of your Google Drive.

1. Select the desired file, making sure that it has a check mark to the right of it.
2. Then click either EMBED or LINK to insert the document into the Rich Text Area.
DO NOT click the Google Docs Home button

⚠️ After embedding a Google Doc document in a Canvas page, you will be able to edit the document and your changes will be automatically saved. Do not click the Docs Home button however, since it will not display in this embedded view.
How do I set up a Google Docs Cloud Assignment in Canvas?

In this tutorial, you will learn how to set up a Google Docs Cloud assignment. This will allow you to embed a Google Document that students will be able to modify and submit a copy of through Canvas.

1. Create an assignment

If you need additional help creating a Canvas assignment, it can be found here.

2. Set the Submission Type

In the assignment options, under Submission Type select External Tool.

![Submission Type](image)
1) Select the drop down in the **Submission Type** options.

2) Select **External Tool** for the drop down.

### 3. Find Google Docs Cloud Assignment

In the **External Tool Options**, click **Find** and then locate **Google Docs Cloud Assignment**.
4. Find the document to embed

In the Google Docs file browser, locate and select the document you would like students to modify and click submit.
5. Finish the configuration

Click Select on the Canvas External Tool configuration screen to finish the embedding process.

6. Review

Review/Finish your assignment options and Save or Save & Publish your assignment.

Instructor view of Google Docs Cloud assignment

The highlighted (yellow) portion is the assignment description.

The contents of the red box are automatically displayed when using the Google Docs Cloud Assignment external tool.
Student view of Google Docs Cloud assignment

The student view will be the same other than the automatically displayed content explaining the embedded document and the presence of the **Submit** button.
Students who have not authorized Google Docs in Canvas

If students receive the following message, they will just have to click **Authorize** on the bottom of the page.

```
Assignment Description goes here.

Students: Modify this copy of the document and click the Submit button at the top of the page.
```

**Log In**

You need to authorize this integration in order to use it.

Please sign in to your Google account and authorize this integration.
How do I use a Google Doc as a Canvas assignment description/prompt?

In this tutorial, you will learn how to use a Google Doc (document) as a read-only assignment description in Canvas.

💡 The benefit here is that you can make changes to one Google Doc and the changes will be reflected anywhere that Document is embedded or linked.

1. Create a new assignment

If you need additional help creating a Canvas assignment, click here.

2. Add a Google Drive Item to the Assignment Description

Above the assignment description text area, click on the blue, downward pointing arrow for More External Tools, and select Google Drive.

3. Find the desired document

Locate and select the document to be used as an assignment description/prompt and decide whether to embed it in the page or link to it externally.
In this case, it is recommended that you embed the document.

If you chose **embed**, in the assignment editing window, you will see your document embedded in the assignment description area.

### 4. Review

Review/Finish your assignment options and **Save** or **Save & Publish** your assignment.
Instructor view of assignment

Your view of the assignment should look something like the following:

Student view of assignment

From the students' perspective, the assignment will look like the following, with the embedded document appearing as View only and a Submit Assignment button (if the submission type was Online).
Students who have not authorized Google Docs in Canvas

⚠️ IMPORTANT MESSAGE: Before you begin, make sure you are not logged in to Google or your Chrome Browser with a personal account other than your HSU account. This can cause problems with the integration.

If you think you have a personal account linked, or are experiencing difficulties, please follow this [guide to unlink a Google account](#).

If students receive the following message, they should just have to click Authorize on the bottom of the page.
Log In
You need to authorize this integration in order to use it.
Please sign in to your Google account and authorize this integration.
How do I submit an assignment from Google Drive in Canvas?

In this tutorial, you will learn how to embed a Google Drive document into a Canvas assignment submission.

1. Navigate to the Canvas Assignment

From within your Canvas course, navigate to the assignment you'd like to submit.

2. Navigate to the submission screen

Click on Submit Assignment.

3. Choose your submission method

⚠️ These options will differ based on what types of submission your instructor has allowed for the assignment.
There are two options for submitting a Google Drive file as an assignment submission: (Instructions for each can be found below)

1) Embed the Google Drive File into a text entry
   - If your instructor has allowed text entry submissions you can embed a file from Google Drive into the text area.
   - This method will submit to your instructor a view-only perspective to the file, but you will be able to continue editing.

2) Select the file from the Google Drive tab
   - This method will submit to your instructor a copy of the current version of your Google Drive file.
   - You will NOT be able to continue editing.

4. Submit Assignment

Option #1: Embed the Google Drive File into a text entry

From the submission type tabs, select **Text Entry**.

Click the **More External Tools** dropdown arrow then **Google Drive**.
Select the desired file then click **MBED**.

Check that you can see your embedded file and click **Submit Assignment**.
Option #2: Select the file from the Google Drive tab

From the submission type tabs, select **Google Drive**.

Select the desired file then click **SUBMIT** or **LINK**.

The **SUBMIT** option will create a Word document (.docx) version of your Google Doc and submit it.

The **LINK** option will submit an embedded Google Doc, which will reflect changes made outside of Canvas after submitting.
IMPORTANT: There is a maximum Google Doc file size limit of 10.4 MB while using the LINK option. If you have a document larger than 10.4 MB, Canvas will not warn you and your submission will appear to have completed successfully.

While working with large documents, it is best to check on this before submitting. In the Google Document, click on **File --> Download as... --> Microsoft Word (.docx)**.

If the **Microsoft Word (.docx)** option is greyed out, this means that the file is has exceeded the size limit to be converted to a Word Document.
Check that you can see your file name and click **Submit Assignment**.
How do I create a copy of a Google Doc to post as a Discussion reply?

In this tutorial, you will learn to make a copy of a Google Doc posted by your instructor in order to edit and post your version as a Discussion reply.

⚠️ Important: Please make sure you are only logged in to your HSU Google account anywhere in the browser you are using, including to the browser itself.

Being logged in to another Google account, such as a personal account, could cause problems with this process.

1. Open the discussion

Open the Canvas course discussion where the Google Doc is posted.
2. Copy the Google Doc

Create a copy of the Google Doc by clicking **File -> Make a copy...**

3. Name the copy

Rename your copy, likely including your name, and click **OK**.
4. Edit the copy

Your copy of the Google Doc should be automatically opened in a new window. This is where you will edit the document before embedding it in the discussion.

Your changes will be saved automatically.

5. Reply to the Discussion Post

From the Canvas discussion, click **Reply** at the bottom of the page.

6. Embed the Google Doc

Click the **More External Tools** button displayed as a blue downward arrow icon, and then on **Google Drive**.
Locate your Google Doc by searching or browsing the list of your Google Drive contents. Select the document and click **EMBED**.

Click **Post Reply** on the bottom-right.
7. Check the reply

Congratulations! You should now have successfully shared your Google Doc. You will now be able to update the document and your updates will appear in the embedded document in the discussion forum.
HSU QLT Course Roadmap

Course Information

Course Name: [Course Name]
Format (f/f/online/hybrid): [Format]
Semester/year: [Semester/year]
How do I embed a Google Form in a Canvas discussion?

In this tutorial, you will learn how to create and embed a Google Form into a new Canvas discussion topic.

⚠ Make sure that you use your Humboldt State University Google account to create your form and response sheet.

1. Log in

Either through myHumboldt or Google, log in to your HSU account.
2. Navigate to Google Drive

You can access Drive through the Applications button on the Google Homepage or by searching for "Google Drive."

![Google Drive Menu](image)

Google Drive - Cloud Storage & File Backup for Photos, Docs & More

- **Download Google Drive**
  A new way to access all of your Google Drive files on demand...

- **Google Drive – Cloud Storage**
  Drive starts you off with 15 GB of free Google online storage, so...

- **How to use Google Drive**
  Android - System requirements - iPhone & iPad - ...

- **Using Drive**
  Learn about the latest features and advantages of Google Drive...

- **Cloud storage**
  Store, sync and share documents and data with Google Drive, an...

- **Google Drive Help**
  Official Google Drive Help Center where you can find tips and...

[More results from google.com]
3. Create a new folder

Create a folder to house your Google Form and Response Sheet by clicking NEW -> Folder.

Name your folder (e.g. COMM 100 Survey) and click CREATE.

4. Create a new form

Create a form by clicking NEW -> More -> Google Forms.
5. Edit your form

Give your form a meaningful name and description then use the interface to add questions. You will most likely use the short answer or multiple choice question types. Use the **Add option** button to add answers to multiple choice questions. Use the + button to add questions.
6. Modify the form's settings

1. Click on the **Settings Gear** in the upper right corner.
2. Uncheck the box next to **Collect email addresses**.
3. Check the box next to **Restrict to Humboldt State University users**.
4. Check the box next to **Limit to 1 response**.
5. Click **SAVE**.
7. Modify your form's responses settings

1. Click on the Responses tab.

2. Click on the green button to 'Create spreadsheet'.
8. Create a new spreadsheet

1. Select the **Create a new spreadsheet** option and rename your sheet if you'd like.
2. Click **CREATE**.

💡 Your Google Sheet should open in a new tab.

9. Copy the embed code for your form

1. From the form editing page, click **Send**.
2. Click on the **embed tab** denoted by the '<>' symbol.
1. Click **Copy** to copy the embed link to your clipboard.
2. Click **X**.
10. Navigate to the Canvas Discussion

Navigate to the Canvas course where you would like to embed the form and click **Discussions** in the Course Navigation Menu.

![Canvas Course Navigation Menu]

11. Create a new Discussion

Click **+Discussion** to create a new discussion.
12. Title the Discussion post

Give your discussion a meaningful title. If your classmates will be posting forms to discussions as well, you will most likely include your name in this title.

13. Embed the Google Form

Click on HTML Editor then paste your previously copied embed code into the text area.
The embed code should look something like the code below. (An HTML iframe)

```html
<iframe src="https://docs.google.com/forms/d/e/1FAIpQLSjT7B04TiaH1X0j_Clt2iHo8mRo7Wd41qPHouSnp8AQ/viewform?embedded=true" width="760" height="500" frameborder="0" marginheight="0" marginwidth="0">Loading…</iframe>
```
14. Save changes

Click **SAVE** to save changes and view your embedded Google Form.

You should now see your Google Form embedded into a new discussion topic.

15. Test the Form

You can fill out the form and submit it to test your automation process.
Immediately after submitting the form, you should see a new row in the Responses spreadsheet.

<table>
<thead>
<tr>
<th>Timestamp</th>
<th>Did you enjoy my presentation?</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/26/2017 14:48:21</td>
<td>Yes</td>
</tr>
</tbody>
</table>
How do I use Google Forms and Sheets to automatically generate custom certificates?

In this tutorial you will learn how to auto-generate individualized certificates using Canvas, Google Forms, and Google Sheets.

1. Create a new folder in Google Drive

This new folder will hold everything you are about to create as well as the generated certificates.
2. Create your certificate

You can copy and modify this certificate or create your own using Google Docs.

1. Select the File menu.

2. Select Make a Copy... from the File drop down menu.

3. Name your template

4. Locate your previously created folder.

5. Click Select
6. Click OK

3. Edit your certificate

In Google Docs, edit your certificate to fit your needs. Use the <<tag>> format for areas that will be auto-completed.

These tags will tell the autoCrat addon where to place the form information in the certificate.
Changes are automatically saved in Google Docs, so click the three bars in the top left corner to return to your Documents.

4. Create your form

Return to the Google Drive folder you created and create a new Google Form.

1) Select **New**

2) Select the **More** option from the drop down menu.

3) Select **Google Forms**
5. Edit your form

Give your form a meaningful name and description then use the interface to add questions. You will most likely use the short answer question type.

⚠️ Make sure to toggle the questions to be Required for any questions that are mandatory or will be used in the creation of the certificate.
6. **Modify your form's settings**

1. Click on **SEND** in the upper right corner.
2. Then check **Automatically collect respondent's Humboldt State University email address**.
3. Click X to close.

7. **Modify your form's responses settings**

1. Click on the **Responses** tab.
2. Then click on the **green button** to 'Create spreadsheet'.

3. Select the **Create a new spreadsheet** option.

4. Edit the name if you'd like, then click **Create**.

8. **Set up your response sheet to use the autoCrat addon**

The newly created sheet should have automatically opened in a new tab. If not, open it from the Google Drive folder that we created at the beginning of the tutorial.

1. Click on **Add-ons**.

2. Click **Get add-ons...**
In the search bar, type autoCrat and hit the Enter key, then click on the + FREE button.

1. If necessary, log in with your HSU Google account.
2. Click Allow to grant autoCrat necessary privileges.
9. Create a new merge job in autoCrat

After installing autoCrat, the following window should be displayed. Click **New Job** to create a new merge job.

If you don't see the pop-up window above, click on 'Add-ons' > 'autoCrat' > 'Open'.

This is how you can get to the autoCrat menu in the future as well.
1. Name your new job - perhaps with the name of the form or course.

2. Click **Next**.

3. Click on **From Drive** to select the certificate template you created earlier.

4. Choose your certificate template.
5. Click **Select**.

6. Now click **Next** to continue with the selected template.

You will now match the tags in your certificate to columns in your spreadsheet.
Use the dropdown windows to select the proper column for each tag, then click **Next**.
1. Decide how you would like to name the files (certificates) that are generated by this merge job.

Click on the **blue bar with an arrow** on the left to see a list of available tags, and right-click them to copy them.

You can paste these tags in the **File Name** textbox to create individualized certificate names.

  e.g. " <<Full Name>> Certificate - <<Course Name>> "

2. Then in the **Type** dropdown, select **PDF**.

3. For the **Output as** field, select **Multiple output mode** so each person gets their own document, rather than a single document with many pages that only you get.

4. Finally, click **Next** to continue.
1. Select your folder.

💡 If your folder is not displayed, click the + Choose folder button.

2. Click **Next**.
No action is required on the next two screens (Steps 6 and 7) so simply click **Next** twice.
You will now decide how the certificates will be sent to recipients.

The following settings are recommended:

- Share doc? - Yes
- Share doc as - PDF
- Allow collaborators to re-share - No
- Send from generic no-reply address - No

- To: Use the blue bar again to copy the email tag and paste it here
- Cc: None
- Bcc: None
- Reply To: Your email (or alternate desired email) address
- Type in Subject: You can use tags here if you would like to include individualized information in the email subject line
- Type a message: You can use tags here if you would like to include individualized information in the email body

When you are finished, click Next.
1. Select **Yes** for **Run on form trigger** if you would like certificates to be generated automatically on form submission.

2. Select **Yes** for **Run on time trigger** if you would like certificates to be generated every:
   - one hour,
   - two hours,
   - three hours,
   - four hours,
   - six hours,
   - twelve hours,
   - twenty-four hours

In either case you will be asked to enable triggers, click **YES** to confirm these changes.
3. Then click **SAVE** to finish creating your merge job.

10. Add your Form to Canvas

At this point, you have finished setting up the automation process and just need to add your Google Form to a Canvas page.

First, let's get the embed link for your Form.

Go back to your folder and open your Form.

1. Click **SEND**.

2. Click on the **embed tab** denoted by the '<>' symbol.
3. Click **COPY** to copy the embed link to your clipboard.

4. Click **X**.

Now, let's embed this form in Canvas.

Navigate to your Canvas course page and decide where you would like students to access this form.

For example, you could add a certificate at the end of each module or at the end of the course. In any case, you will be embedding the Google Form in a **Canvas content page**.
1. Inside the page edit screen, click on HTML Editor.

2. Paste the embed link you copied before.

3. Then Save or Save and publish your page.

Your Form should now be embedded in your page!
11. Test your Form

You can fill out the form and submit it to test your automation process.

Immediately after submitting the form, you should see a new row in the Responses spreadsheet.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Timestamp</td>
<td>Email Address</td>
<td>Full Name</td>
<td>Course Name</td>
</tr>
<tr>
<td>2</td>
<td>9/22/2017 13:53:50</td>
<td><a href="mailto:ndo28@humboldt.edu">ndo28@humboldt.edu</a></td>
<td>Nathan Ortolan</td>
<td>Nathan's Sandbox</td>
</tr>
</tbody>
</table>

You should receive an email containing a PDF certificate shortly after submitting the form.

⚠️ If you chose to trigger the merge job on a timed schedule, this will dictate when the certificate will be emailed.
12. Example Certificate

Humboldt State University

CERTIFICATE OF COMPLETION

This certificate is granted to

Nathan Ortolan

In recognition of completing the Nathan's Sandbox training course on Canvas.

NATHAN ORTOLAN
INSTRUCTIONAL SUPPORT ASSISTANT

COMPLETION DATE
9/22/2017
How do I use Google Sheets to update course Assignments and Quizzes in bulk?

In this tutorial you will learn how to use Google Sheets to make updates to your Canvas assignments and quizzes.

From the pre-made spreadsheet, you can edit assignment names, due dates, available dates, publish items and more!

1. Open the pre-made Google sheet

Click on the link to open the sheet: Course Due Dates

2. Copy the spreadsheet

This is a read-only spreadsheet and you will need to make your own copy to use in your Google Drive.

Go to File > Make a Copy
3. Name the spreadsheet

💡 Name your copy (perhaps with the course title included) and click OK.

4. Check the timezone settings

In the document settings check the timezone to make sure it is set appropriately.

1) Select Spreadsheet settings... from the File dropdown menu.
2) Select the appropriate time zone.

3) Click **Save settings**.
5. Generate an Access Token

From within Canvas, navigate to your **Account Settings**.

Scroll down to the bottom of the **Approved Integrations** list and click on **+ New Access Token**
"Name" your Access Token in the Purpose textbox (You may want to include the course name here as well)

Leave the expiration date blank and click **Generate Token**
Highlight and copy the generated access token.

- For Windows users: right-click the link and select copy or use keyboard shortcut <ctrl>+c
- For Mac users: right-click (<ctrl>-click) the link and select copy or use keyboard shortcut <cmd>+c
6. Configure API Settings

Return to the Google Sheet you named in the above steps, then authorize the sheet for your account.

1. Click **Configure API Settings** from the Canvas drop down menu.

2. Click the **Continue** button to authorize.

3. Select your Google account.
4. Click the **Allow** button.

7. Fill in hostname and access token

For Humboldt State University users,
Canvas Hostname:  canvas.humboldt.edu

Access Token: <Paste your access token here>

- For Windows users: right-click in the text area and select paste or use keyboard shortcut <ctrl>+v
- For Mac users: right-click (<ctrl>-click) the text area and select paste or use keyboard shortcut <cmd>+v

Then click Submit.

8. Specify your Canvas course

From the Canvas dropdown menu, choose Specify Course.
From your Canvas course home page, copy the contents of the address bar. It should look like this: [https://canvas.humboldt.edu/courses/12345](https://canvas.humboldt.edu/courses/12345)

⚠️ Make sure you are on the course home page, and there is nothing following "/courses/#####"

In Google Sheets, paste this web address into the textbox to specify the course ID.
Click on **Yes** in the pop-up asking if you would like to proceed.

**9. Load the current assignment data from Canvas**

From the Canvas menu, choose **Load Due Dates** to populate the spreadsheet with the current information from Canvas.

⚠️ Make sure you always **Load Due Dates** before making changes to the sheet to ensure the most current dates have been imported from Canvas.

**10. (OPTIONAL) Reformat dates**

From the Canvas menu, choose **Reformat Dates** to fix the display / auto-adjust column widths / re-sort the items.
11. Modify the assignment data

You are now able to modify the contents of the spreadsheet accordingly.

Date format: mm/dd/yyyy hh:mm:ss
Publish format: 1 = published, 0 = unpublished

⚠️ Use the function bar (labeled fx) for modifying dates. You can enter dates in the cells in mm/dd/yy format, then use the Reformat Dates (step 10 above) to format the dates before reloading the data to Canvas in Step 12. The default time will be 12 AM.

⚠️ Show/Hide Answers columns are for quizzes only. They expect a date to be input and the changes will only be saved if the quiz is already set to show correct answers.
12. Upload your changes to Canvas

When you are satisfied with your changes, choose **Save Due Dates** from the Canvas dropdown menu to upload them to Canvas.

![Canvas due dates screenshot]

13. Check Canvas for your changes

It is always a good idea to double check that your changes have been reflected in your Canvas course.
How do I submit a Google Docs Cloud Assignment as a student?

In this tutorial you will learn how to submit a Google Docs Cloud Assignment as a student.

If your instructor has set up a Google Docs Cloud Assignment, you will receive a copy of their document when you navigate to the assignment page.

You will submit your modified copy of their Google document directly through Canvas.

1. Navigate to the assignment

If you need help navigating to a Canvas course, please follow this guide.

You should see the following banner above the Google Doc:

```
The embedded document below is a document that your teacher has created for you called a Cloud Assignment. You'll be able to edit the document in Canvas or in Google Documents. Once you have completed the assignment, you'll be able to submit it by using the submit button located on this page.
```

2. Modify the document as needed

Follow your instructor's directions to modify the Google Doc as required in the assignment description.
3. Submit the assignment

When you are ready, click **Submit** to submit your modified copy of the Google Doc.

Under the document's title, you should see a timestamp of your submission.

You can continue modifying if necessary and submit again. Your instructor will receive each submission separately, but they will see the most recent version first when grading.
How do I open Microsoft Office Files (Word, Excel, PowerPoint) on my Chromebook?

In this tutorial you will learn how to open, edit, and save Microsoft Office Files using a Google Chromebook.

Download a Microsoft Office File

In this example, we will download a Microsoft Word document (.docx) from Canvas.

For help downloading a file from Canvas, follow this guide.

Locate the File in File Explorer (Downloads)

The Download Manager should notify you of the recent download.

Click SHOW IN FOLDER to open the downloads folder.
Open the File using Google Docs

**Double-click** the File to automatically open it using Google Docs.

In the address bar, you should see that the file is being viewed through the **Office Editing for Docs, Sheets & Slides** extension.

If you only need to view the file, you are done!

If you'd like to edit and save the file, continue in the next section.

**Edit the File using Google Docs**

Edit the file as needed and your changes will be saved automatically (locally to your Chromebook).
HSU Accessible Syllabus Template

Here are some obvious edits!!!!

Revised 2/18 - per March 2016 HSU policy, accessibility reviewed
Syllabus Addendum - Campus Resources Policies
HSU Syllabi Policy

Since your changes are saved automatically, you can close the tab at any time.

To reopen the document, simply double-click the local file again.
How do I create a new Microsoft Office File (Word, Excel, PowerPoint) on my Chromebook?

In this tutorial you will learn how to save a Google Suite File (Doc, Slide, Sheet) as its Microsoft counterpart on a Google Chromebook.

Create a Google Suite File

In this example we will create a Google Doc and save it as a Microsoft Word file (.docx).

From the Google Docs homepage, click on + Blank to create a new, blank Doc.

Title and Edit your Document

Give your document a title and make any necessary edits.
Save the Document as a Microsoft Office File

1. Click **File**
2. Hover over **Download as**
3. Click **Microsoft Word (.docx)**

Your document should appear in your Downloads folder.
How do I use the Google Calendar?

Google Calendar is a powerful scheduling tool that allows you to create, share, and view events across calendars. Here are some of the features:

- Faculty and student calendars are automatically synced with their class schedules.
- You can add and view other users' schedules and request to view their full calendars.
- Along with each user having a personal calendar, calendars can be created for courses, projects, or any group.
- Zoom Meetings can be scheduled directly through Google Calendar with the Zoom Scheduler Extension for Chrome.

In this tutorial you will learn how to use the many features of the Google Calendar.

Getting to your Calendar

Go to [https://www.google.com](https://www.google.com) and check if you are signed in in the top right corner.

If you are signed in to your HSU Google account, you should see either a picture that you uploaded or the first letter of your first name.

If you are not signed in, click the **Sign in** button and use your HSU credentials to log in.

In the top right corner, click the **Google Apps button** (3x3 grid) then click **Calendar**.
Viewing Events

Google Calendar will display your personal calendar, your coworkers’ calendars that you have added, as well as any calendars that have been shared with you or that you have created.

Each calendar will be displayed using a different color for its Event cards.
Navigation

To navigate between pages, use the **left and right arrows** in the top left.

To navigate more quickly through months, use the **left and right arrows** in the month preview on the left.
Quickly jump to the current date at any time by clicking **TODAY** in the top left.

### Switching views

To **toggle which calendars appear** in your current view, check/uncheck the boxes to the left of each calendar.
To change the color or settings of each calendar, **hover over** the item then click the **three dots** to the right.

To switch between views (Day, Week, Month, Year, Schedule, and Custom) click the **View dropdown** to the left of the Settings gear.

You can also use the keyboard shortcuts displayed to the right of each option.
Adding Calendars

To add another user's calendar, begin typing their name or email in the **Add a coworker's calendar** text box.

To add a calendar other than a user's, click the **+ button** next to Add a coworker's calendar.

You can add:

- a **resource's calendar** (classroom/lab)
• a calendar from URL  
• calendars of interest (holidays, sports, etc.)

or you can create a new calendar.

Creating Events

To create a new Event, click the + button in the bottom right corner.

Event Name and Scheduling

Name your Event in the title bar at the top of the page.

Click the default dates and times to adjust when your Event will take place.
You can also use the **Find a Time** feature once you have added guests.

If this will be a recurring Event, choose an appropriate option from the **Does not repeat** dropdown.
Event Details

Add a location for your Event. This can be a real address or something like "Third Floor of the Library."

You can Add Conferencing to your meeting through Google Hangouts if your meeting requires outside discussion, or if you have guests that can not attend.
Modify the name of the Hangout in the text box to the right.

Add Notifications to remind you of your meeting.

These can be sent as emails or Desktop/Mobile Notifications if your device has Google Calendar notifications enabled.
How to change your Google Calendar notifications settings on:

- Desktop
- Android
- iPhone & iPad

Choose which calendar to add the Event to. All calendars that you have editing privileges of are displayed.

Toggle the color of the Event card with the color dropdown to the right.
Select how Google Calendar will **display your availability** to others during the Event.

Select how Google Calendar will **display the Event itself** to others who can view your calendar.
Add a description to your Event with the text editor. Here you can attach files, insert links, and input lists (numbered or bulleted).

Guests and Rooms

In the panel on the right, you can select guests to add by beginning to type their names or email addresses.
Decide what privileges invited guests should have over this Event.

Click the ROOMS tab to view available HSU classrooms and labs if you'd like to schedule your meeting in a specific place.
Clicking a room will add the name of the room to the **Location** field, as well as add the room (resource) to the **guest list**.

**Find a Time**

Once you have added guests to your Event, you can use the Find a Time feature to **browse each attendees personal calendar for their availability**.

This way you can find a time that works for everyone involved without asking anyone for their availability.
Each member's calendar will be displayed using a different color for the Event cards. You can **toggle which calendars will be displayed** using the Guests panel on the right.

You can **drag and drop the empty, gray card** to adjust when your meeting will take place. Notice that the date and time fields above change accordingly.
Saving your Event

You can save your changes to the Event at any time by clicking **SAVE** in the top middle of the screen.

If you have added guests to your Event, you will be prompted to send invitations. Select **Cancel Changes, Don't Send**, or **Send**.
If you have attached a Google Drive file that is not shared with all guests, you will be prompted to share the file.

Click **More options**.

1. **Select Guests of this event**
2. Decide what **privileges** guests should have over the file
3. Select **Share & Save**
Calendar Settings

To change your overall Google Calendar settings, click the **settings gear** in the top right, then click **Settings**.

Here is a list of **settings categories** you can adjust. Use these links in the top left to jump to a category.
From the Settings page, you can **adjust individual calendar settings** by clicking the calendar's name.
Schedule a Zoom Meeting

Follow this guide to schedule Zoom Meetings within Google Calendar.
How do I schedule a Zoom Meeting using Google Calendar?

In this tutorial you will learn how to schedule a Zoom Meeting as a Google Calendar Event.

Add the Zoom Scheduler to Chrome

If you are using a campus computer, you can skip this step.

Before scheduling Zoom Meetings within Google Calendar, we need to install a Google Chrome Extension called Zoom Scheduler.

Use Google Chrome Browser to open this link to the Chrome Web Store.

In the top left corner of the screen, search for Zoom Scheduler.

Click on the Zoom Scheduler by Zoom-for-Chrome.

Click + ADD TO CHROME to install the Extension.
Create a new Google Calendar Event

Click the + button in the bottom right corner of Google Calendar.

Make it a Zoom Meeting

After modifying your Event settings and guest list, click on Make it a Zoom Meeting.
If you are not currently logged in to Zoom, you will see the following error message.
Click **OK**.

Click on the **Zoom Icon** in the top right corner of the Chrome Browser.

Click **Sign In with Google**.
If you are asked to choose an account, select your **HSU Google account** (e.g. abc123@humboldt.edu) and log in through the myHumboldt portal.

In the Google Calendar Event, again click on **Make it a Zoom Meeting**.
Use the popup window to select your Zoom Meeting options.

Click **Continue** when you are finished editing.

The meeting location and meeting description boxes will have been changed automatically by the Zoom Extension.
You can **modify the description** to include additional or alternative information, but you should include at least the **meeting link** and the **meeting ID**.
Click **SAVE** when you are finished editing your Event.
How do I copy the contents of my U drive to Google Drive?

In this tutorial you will learn how to copy the contents of your public_html folder on the HSU U-drive to Google Drive.

⚠️ This process must be completed on a campus computer that is mapped to the U-drive. WinSCP, Cyberduck or other file transfer application can be used to move the files from your home computer.

Windows version

1. Find the public_html folder in the U-drive

Open the File Explorer

Locate the U-drive in the File Explorer

1. The U-drive should be mapped to the Network locations in the directory
2. It should be identifiable by having your HSU username on the title
3. Click the icon or title to open the U-drive in the File Explorer
Locate the public_html folder in the list of folders in the directory list.
2. Open Google Drive using your HSU-associated email

**In a browser window, type Google Drive in the search bar**

Click this [link](#) to open Google Drive

**Open Google Drive**
Sign-in to Google Drive with your HSU-Username email address

Enter your HSU email address, then click "Next"
Login to your HSU account

3. Create a folder in Google Drive for your content

Click "New" to open the dialog box
Select "Folder" from the dialog box

Create the folder

Enter a name, then click "Create"
4. With both windows open on the Desktop, drag the Public_html folder to the new folder in Google Drive.

Mac version

1. Connect to the U-drive (remote server) via the Finder's Go Menu

2. Open the Finder window

2. Open the Go menu
3. Click "Connect to Server" in the pop-up Menu

4. In the Connect to Server dialog box, enter: smb://folders.humboldt.edu/<userid>

5. Click Connect

⚠️ Replace the <userid> portion of the above address with your HSU User ID. For example, if my name were Adam B. Couch and my HSU User ID was abc123, I would enter smb://folders.humboldt.edu/abc123
2. In a browser window open Google Drive

⚠️ Be sure you are logged into your HSU gmail account.
3. Upload the public_html folder to Google Drive

Click "New" button on at the top of the Google Drive menu

Click "Folder upload" on the pop-up dialog box
1. The "Shared" section should list the remote server (folders.humboldt.edu), double click to open the directory

2. Locate the folder with your Username and open the folder with double click
Locate the public_html folder, select it and click Upload
A dialog box will open to warn you to only upload these files if you trust the site.

Click Upload on the dialog box to complete the process. The upload will begin.

Upload 27 files to this site?
This will upload all files from "public_html". Only do this if you trust the site.

If you need to share this folder with another user. Please follow [this Google Support guide on Sharing Folders via Google Drive](#)
How do I share contents of my Google Drive with my class (using CRN)?

In this tutorial, you will learn how to share your Google Drive contents with your HSU class using the class CRN.

1. Login to my.humboldt.edu
   1. Type your HSU username
   2. Type your password
   3. Click the Log In button

2. Go to Gmail
   Click on the Gmail button on the myHumboldt page.
3. Open Google Drive

1. Click on the **Google Apps** icon on the upper right side of the screen
2. Click on **Google Drive**

4. Click on the folder or item you want to share with your class.
5. To share a folder...

1. click on the folder
2. Click on the folder options (down pointing triangle)
3. Click on Share

Type your class CRN into the "Enter names or email addresses..." search bar

1. Type the CRN into the search bar
2. Click on your course
3. Click Send

⚠️ If you do not select the class then your Google Drive contents will not be shared with your class.